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Needle Notes
This issue of Through the Needle ONLINE is all about creative freedom – venturing
outside our boxes and trying new sewing and embroidery techniques. One of my
sewing teachers from way back when – I don’t remember who – gave her students
“permission slips” encouraging them to break away from traditional stitching and
embellishment techniques. We like the idea so much that we’re giving permission
slips to all our readers—so get out your sewing machine(s) and play!
Jerilynn Lijewski gives students carte blanche to design endless stitched blocks
for her “Permission Purse,” providing step-by-step directions for creating pattern
run designs in BERNINA Embroidery Software 6. Kerry Finn encourages readers
to play with decorative threads and practice free-motion stitching techniques as
they create beautifully-stitched table runners, and Alison Stilwell describes her
process for creating a whimsical floral landscape by needle-punching roving,
yarn, and hand-dyed fabrics into a felt base. Ready to update your wardrobe?
Jennifer Gigas up-cycles two “okay, but boring” cardigan sweaters into a chic
pullover tunic.
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Want that “free spirit” look but just can’t get it right on your own? Free-form floral
appliqué and embroidery designs from OESD’s new Bold & Beautiful collection #80001—
paired with coordinating fabrics from Benartex—embellish a variety of picnic accessories.
We’re ready and waiting for spring!
Visit www.ThroughTheNeedle.com for back issues of Through the Needle ONLINE, and
visit the BERNINA USA blog, www.WeAllSew.com, for more sewing and up-cycling
inspiration. What have you been stitching this winter? We’d love to see your projects and
technique swatches!

Jo Leichte
Editor

Monster Pillow
Who said that a monster couldn’t be adorable? This soft cuddly pillow
sports a friendly monster face you can’t help but love and it’s just the right
size for kids to hug. Plus it’s easy to make so it won’t turn into a monster
project ... so why make only one? Friendly monsters are welcome in your
little one’s room and in the car. This monster pillow is also a great gift idea
for your little one’s pals, too.
Project by Ashley Johnson
Visit WeAllSew.com for more project instructions and sewing tips!
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Quilting

with
Decorative Threads
by KERRY FINN

Do you have a collection of beautiful,
decorative threads that are hiding in a
drawer? Many of us buy them but are not
successful using them because they often
present stitching challenges. The solution?
Most of the frustration can be eliminated
by choosing the right needle for the thread
you are using. A quilted table runner is
the perfect project for showing off the
decorative threads you’ve collected while
practicing your free-motion stitching skills.
Supplies
•
•
•
•
•
•
•
•

Two coordinating batiks, ½ yard each
Fabric for backing
Fabric for binding the runner
Batting
Assorted decorative threads
Assorted Embroidery and Topstitching needles
Color wheel

Using a dark fabric for the backing turns your work
into a reversible runner—the back will be as beautiful
as the front when you are finished stitching. For the
backing you’ll need a piece of fabric a bit larger than
the assembled runner panel with borders.
Many quilters match thread to their fabric, and when
the quilt is finished the beautiful quilting designs
disappear into the background. For this project choose
thread in colors that contrast with the fabrics you’ve
chosen. We want to see the stitching and the thread, so
select high-contrast threads instead of colors that match
the fabric. Use a color wheel to select a complementary
color scheme. For example, if your fabric is purple, quilt
with lime green.

thread color

Chalk marker

Fabric and Thread Selection
For this runner, choose two fabrics for the front of
the runner—one for the center panel and one for the
contrasting border. Also select a black or dark-colored
fabric for the back. Dig out those beautiful batiks that
you just couldn’t cut into and use them as a canvas
to show off your stitching skills. Or select two similar
fabrics that don’t have a strong, patterned design.

fabric color
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Cut the Panel and Add the Borders
Determine how wide and how long you want the
center panel of the runner to be, knowing that you will
be adding the contrasting border all around. Allow for a
3’’- or 4”-wide border.
To the desired finished width and length for the center
panel, add ½” all around to allow for ¼”-wide seam
allowances.
Cut a piece the determined width across the width of
the fabric that you selected for the runner body.
For the contrast borders, cut 3”- or 4”-wide border
strips. Cut two strips the length of the center panel
and stitch them to opposite long edges. Press the seam
allowances toward the borders. Measure the width of
the runner with the borders and cut two border strips
this length. Sew them to the remaining edges of the
runner and press the seam allowances toward the
borders.

I like to use Organ Embroidery needles. They appear
gold in color and last at least five times longer than
regular needles.
The threads used for the projects shown on these pages
vary from cotton to silk to polyester, and I used two or
three different threads on each runner. The majority of
decorative threads will perform better with a size 90/14
needle; for example, a 90/14 Topstitch needle works
beautifully with Rainbows variegated threads from
Superior Threads.
For more information on choosing the proper needle for
the thread you’ve chosen, go to the Superior Threads
website: www.superiorthreads.com.
Inspiration for the table runners shown here came from
Diane Gaudynski, Ricky Tims, Libby Lehman, and Laura
Heine. Use your favorite designs and start quilting.
Give yourself permission to play and have fun!

Free-motion Quilting
For your practice table runner, use chalk to mark some
basic shapes such as the curve of a feather or flower on
the assembled runner. Then use the shapes as guides
to follow while you stitch, practicing different patterns.
Echo the stitching for more interest and to fill in the
spaces.
You may want to keep a journal of all your free-motion
designs as a reference for your quilts. I have kept
one for ten years. I doodle in a smaller notebook and
transfer the pages to my journal so I always have a
“go-to” source for designs.
When you have finished the quilting, trim the excess
backing and batting even with the runner edges. Finish
the edges with binding.

Successful Stitching
The key to success with heavier threads is to marry
the right needle to the right thread. If you are using a
40-weight or heavier thread, use a 90/14 Embroidery
needle or a 90/14 Topstitch needle. Both have a
larger eye and sharper point than a regular needle.
The Topstitch needle also has a deeper groove than
most needles. Remember that the heavier the thread,
the larger the needle size must be. If you experience
skipping stitches while free-motion quilting, the needle
size is most likely too small.
Be sure to begin with a new needle when you start
a new project. Change the needle after 6-8 hours of
sewing.

back

front

6 • THROUGH THE NEEDLE ONLINE

front

This solid-colored runner with a striped border was
quilted with Ricky Tims’ Art Studio Colors polyester
embroidery thread. Notice the “Lava Lamp” design.
You can achieve this pattern by quilting one side of
the bubble starting at the top of the runner. Stitch
all the way to the end, then go back to the top and
stitch the second side of the bubbles, mirror-imaging
the previous stitching. It will help to mark chalk lines
along the length of your quilt to keep the spacing
even and your rows straight. After quilting your rows
of bubbles change colors and echo-quilt between
the rows. This is a good exercise for learning
spacing. Your shapes do not have to be the same
size; it will add character to your piece if they are
not perfect!

front

back

front

back

back

Kerry works full time at Blow's
Sew-n-Vac in Fargo, ND. She
lives just outside of Fargo
in Mapleton, ND, with her
husband, Denny. When she is
not working she enjoys spending
time with her three grown sons
and their families.
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BERNINA Accessory Spotlight:

Hemmer Feet
by SUSAN BECK

2 mm Straight Stitch Hemmer #62
4 mm Straight Stitch Hemmer #64
These feet are for use with
lightweight and sheer fabrics,
resulting in precise, delicate hems.
Used with straight stitch only; single
needle hole offers more support for
the fabric, causing less slippage and
more precision.
2 mm Roll & Shell Hemmer #68
4 mm Roll & Shell Hemmer #69
Precise, double-turned narrow hems are easy to sew
using BERNINA hemmer feet. The napkin shown was
hemmed using 3mm Zigzag Hemmer Foot #63, which
can be used with straight, zigzag, or decorative stitches
up to 5.5mm wide. The method shown also works with
other BERNINA hemmer feet.

Anatomy of a Hemmer Foot

Especially effective for decorative hems on lightweight
knits and lingerie fabrics, these hemmers are designed
for use with side-to-side stitches that wrap around the
outside of the hem at regular intervals, pulling it in to
create a scalloped edge. The channels in the sole are
deeper and rounder than those of the other hemmers,
resulting in round, rather than flat, hems.

Coil: Turns the fabric edge under
twice, holding it in place for stitching.
Needle Opening: Accommodates
stitch width up to 5.5mm wide.
Channel: Provides a path the
width of the finished hem.

Selecting the Correct Hemmer Foot
2 mm Zigzag Hemmer #61
3 mm Zigzag Hemmer #63
6 mm Zigzag Hemmer #66
These hemmers work well on most light- to mediumweight fabrics, using any stitch width up to 5.5mm. The
channel on Foot #63 does not extend all the way to the
back edge of the foot; this makes it ideal for hemming
curved edges.

For a pictorial guide to using the BERINA Hemmer Feet
click here.
For a video guide to using the BERNINA Hemmer Feet
click here.
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Fitting Tips:
Correct
Measurements
by DEBBI LASHBROOK
For garment sewers, the pursuit of good fit is the
ultimate quest. There are many elements which
contribute to reaching this goal: To achieve a perfect
fit you must understand your particular body type,
know your preferred ease type, select a pattern
appropriate for your silhouette, select the correct fabric
for the pattern design, and take an accurate set of
measurements.
Measurements are the key to any well-fitting
garment. Fitting requires adding fabric where extra
is required and taking it away where it isn’t needed,
so it is necessary to know where and how your body
measurements differ from those of the pattern. The
more fitted the garment, the more critical accuracy
is. Comparing your measurements with those on
the pattern envelope provides information on where
alterations may be necessary.
Ease is necessary to produce a good fit. Garments
can be close-fitting, fitted, or loose-fitting, but they
must have enough ease built-in to allow comfortable
movement. Fitting or wearing ease is built into
garments so you can move, bend, reach, walk, and sit.
Fashion or design ease is added to fitting ease to create
the particular style of garment. Most garments have
positive ease—that is, extra fabric around the body—so
the garment does not hug the body. Stretchy garments
sometimes have negative ease—or less fabric around
the body—to provide a close fit.

Precise measuring tools
help achieve a good fit:
• A good quality, accurate tape measure. There should
be no kinks or folds in the tape. Fabric tape measures
may stretch out of shape, causing inaccurate
measurements; plastic ones do not stretch and
• A length of narrow elastic is helpful when taking
waist measurements. Tie it around your and bend
back and forth and from side to side; the elastic will
settle at the position of your natural waistline.
• A ruler with a tape measure attached to it in the
center, perpendicular to the edge, is valuable for
measuring underarm length and underarm waist
length.
• A carpenter’s square, positioned with one leg against
a wall, helps ensure that vertical measurements are
taken parallel to the floor.
• A centering tape measure—one that measures from
the center out to each end—is helpful for measuring
crotch front length and back length. It is also useful
for taking front and back measurements.
• A flexible ruler works well for accurately duplicating
your personal crotch curve, a must when fitting pants.
The ruler curves around the body, then retains its
shape when removed, allowing the curve of the body
to be duplicated in the pattern.
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Tips for Taking Measurements

Rules for Determining Pattern Size

• Locate and mark reference points on the body to aid
in taking accurate body measurements from landmark
to landmark. Check to see which points are noted
on the pattern—generally the locations of the waist,
neck base, and end of shoulder must be marked.
• Have a friend take your measurements; this is always
more accurate than taking them yourself.
• Always wear a good bra and the undergarments you
will wear with the garment; this ensures that your
garment will fit correctly.
• Stand naturally as measurements are taken; don’t
slouch.
• Keep the tape measure taut when taking vertical
measurements.
• Place one finger under the tape measure when
measuring circumference; this ensures that
measurements are not taken too tightly.
• Both length and circumference measurements are
needed, as they are both used to determine where
ease should be included.
• The full bust measurement is taken around the fullest
part of the bust, parallel to the floor.
• The hip measurement is taken around the body,
parallel to the floor, across the largest part of the
buttocks.
• The waist measurement is taken where the body
“sinks in” when the upper body is bent to the side.
• The back waist length is taken from the cervical bone
at the base of the back neck to the waistline at the
center back. It is used when making waist position
adjustments.

• Use circumference measurements to select a pattern
size; the length measurements can be easily adjusted
by adding or subtracting from the length of the
pattern pieces.
• Select the pattern size closest to your measurements,
and then adjust the pattern to fit.
• For blouses, dresses, and jackets, size is generally
based on your upper body measurements; the bust or
high bust measurement is usually suggested.
• Full-busted women should select a pattern size based
on the high bust measurement, which better reflects
the frame of the body. Indicators of poor fit include
armholes that gap and/or too deep, and a neckline
that is too wide.
• Another good size indicator for the fit of upper body
garments is the neck base measurement, taken where
the neck meets the body.
• For pants and skirts, choose your pattern size based
on your hip circumference, and then adjust the waist
to fit.
• If there is a lot of detail in the waist area, select your
pattern size based on your waist measurement.

BERNINA Educational Webinars
...a new way to expand your sewing horizons
Have you heard the buzz? BERNINA offers a wide
variety of FREE Educational Webinars each month.
Join BERNINA’s on-line classroom to learn the latest
tips and tricks on topics ranging from the BERNINA
8 Series to Embroidery Software to Cutwork and
more! Our Just SEW It! Series focuses on projects for
new and re-entry sewers. So, no matter what your
area of interest, we have a class for you!
Sign up at www.berninausa.com to receive BERNINA
Webinar Announcements via email, and visit our
home page for the latest webinar news.
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Picnic in the Park
by JO LEICHTE

Supplies
•
•
•
•

Sunny embroidery and applique designs from BERNINA’s Exclusive Bold &
Beautiful collection are paired with prints the Benartex Bold & Beautiful fabric
collection for accessories that will brighten your next picnic or potluck.

Embroidery machine
Large Oval Hoop (or your largest embroidery hoop)
“Bold & Beautiful” OESD embroidery collection
“Bold & Beautiful” fabric collection by Benartex
- ½ yard or 1 fat quarter of pink stripe (Fabric 1)
- ½ yard of 1 fat quarter of yellow dot (Fabric 4)
- ½ yard or 2 fat quarters for lining bowl covers
- ½ yard floral print for binding
- Assorted pieces of fabric for appliqués
• 1½ yards of 1/4”-wide elastic
• PolyMesh Cut-Away Stabilizer
• 505 Temporary Adhesive Spray
• Isacord embroidery thread in desired colors
• Mettler Metrosene thread for attaching the
binding
• Embroidery needle, size 90/14
• Bias Binder #88 with Foot #95/95C
• Edgestitch Foot #10/10C/10D or Walking Foot #50
with Center Guide
• Stiletto
Note: The double-fold bias tape called for in the
pattern instructions is NOT needed.

Covered with Flowers
Embroidery
Cut out the large and small circles as directed by the
pattern. Cut one large and one small circle from the
lining fabric.
Select the desired designs from the OESD “Bold &
Beautiful” collection #80001. Print the templates from
the design CD, or download the free ArtLink 6 software
from www.berninausa.com > Products > Software and
print templates using File > Print Preview. Be sure to
write the number of each
design on its template.
Position design templates
on the circles as desired,
leaving an “embroideryfree” border about 3”
wide around the outside
edge. Pin in place.
Mark the center of each
design.
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Bond two layers
of stabilizer with
505 Temporary
Adhesive and
hoop them as one
unit, then spray
the stabilizer with
505. Smooth the
fabric into place
on the stabilizer,
positioning as many designs as possible within the
hoop. Remove the templates that are not completely
covered by the hoop.
Open the first design. If not automatically selected, click
on the Design Center icon to move the needle to the
center of the design. Use the positioning arrows and
rotation knobs to position the design within the onscreen hoop to match the positions of the templates in
the actual hoop, matching the center lines as closely as
possible.
Repeat for the remaining designs. Fine-tune placement
as needed. Remove the paper templates.

Sew a basting box around the inside of the hoop
by selecting the Basting Box icon on the BERNINA
830 or 830LE, or download the free files from www.
berninausa.com > See It, Share It > Free Downloads.
Embroider the designs, stitching the appliqués as
directed by the instructions included with the “Bold &
Beautiful” embroidery collection.
After stitching the first set of designs, reposition the
templates for the
remaining designs
on the fabric and
re-hoop the fabric.
Arrange the designs
on-screen as before;
stitch. Repeat as
needed.

When embroidery is complete, trim the excess stabilizer
from around the designs, leaving about ¼” around the
outer edges.
Place the embroidered bowl cover circles back-to-back
with their corresponding lining circles. Pin around the
outside edges to keep the fabric from shifting. Attach
a ¼” presser foot to the machine and stitch around the
circle to stabilizer the edge, using the edge of the foot
as a guide.

Binding
Cut bias strips a scant 1½” wide, approximately
60”-long for the small bowl cover and 75”-long for
the large bowl cover. Stitch the ends together along
the diagonal to make one long bias strip.
Attach Bias Binder #88 and Foot #95/95C to your
sewing machine. With the wrong side of the bias strip
facing left, insert the strip into the binder slot. Using a
stiletto to help it move through the slot, gently pull the
binding through the binder and out the back. Pull until
you see that both edges of the strip are folded to the
middle, and then the entire strip is folded in the center
(about 4” to 6”). Adjust the needle position so that
it will stitch about 2 mm from the inner edge of the
binding.
With the presser
foot lifted, carefully
insert the edge
of the bowl cover
between the folds
of the bias binding.
Lower the presser
foot and stitch
slowly around
the circle, taking care to keep the edge of the fabric
inserted completely into the folded binding.
Stitch, making sure the
bias strip stays flat as it
enters the binder and
flows freely.
Stop about 2” from
the starting point and
remove the bowl cover
from the machine,
leaving a tail of fabric
long enough to cover the unbound edge + about 3”.
Insert elastic as directed by the pattern instructions and
stitch the ends together.
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Trim the shorter bias strip tail to about 1”, then fold it
around the edge and pin it in place. Hand- or machinebaste it in place and remove the pins. Fold the opposite
bias tail on the diagonal, leaving enough fabric to
overlap the basted end by about 1” (make sure the
edges overlap on the top and underneath); trim away
the excess length, leaving ¼” of fabric turned under at
the end. Fold the fabric around the edge of the cover
and pin in place, overlapping the other end of the
binding.
Attach Edgestitch Foot #10 or Walking Foot #50 with
Center Guide to the machine. Place the bowl cover
under the foot,
positioning the
inside fold of the
bias against the
right side of the
center guide. Adjust
the needle position
to the right to
match the previous
stitching. Edgestitch
the binding to the
cover to complete
the circle and close
the opening.

“Casserole” or “Hotdish”?
No matter what you call it, this insulated tote will keep
your picnic and potluck dishes warm. Can’t decide?
Embroidery “casserole” at one end and “hotdish” on
the other!

Supplies
• “Bold & Beautiful” fabric collection by Benartex
- 1 yard or 4 fat quarters of pink stripe (Fabric 1)
- ½ yard or 2 fat quarters of floral pint (Fabric 2)
- ½ yard or 2 fat quarters of green dots (Fabric 3)
- ½ yard or 1 fat quarter of yellow dots (Fabric 4)
• Insul-brite by Warm ‘n’ Natural
• PolyMesh Cut-Away Stabilizer
• 505 Temporary Adhesive Spray
• Water-soluble marker
• “Cut for the Cure” quilters’ ruler, 7” x 14”
• Isacord embroidery thread in desired colors
• Mettler Metrosene thread for construction
• Embroidery needle, size 90/14
• Universal needle, size 80/12 or 90/14
• Patchwork Foot #37/37D or Patchwork Foot with
Guide #57/57D
• Rotary cutting equipment (optional)

Make the casserole following the pattern instructions
EXCEPT – embroider casserole and hotdish on the
ends before assembling the pieces.
After transferring the dots from the pattern pieces to
the fabric, use a water-soluble marker to connect the
dots on the end of the Flap. The resulting rectangle is
the finished size of the tote end, 2” x 10”. Mark the
horizontal and vertical centers of each rectangle.
Allowing about ½” of space at the upper and lower
edges, the maximum letter height is around 1”
(25 mm). Allowing at least 1” of space at each end, the
width of the entire word must be less than 8”
(200 mm).
In your embroidery
machine’s
customizing screen,
input the word
casserole.
Select the lettering
icon and open the
lettering screen. Select an alphabet (sample is Swiss
Block) and activate the lower case characters. (If you
only have upper case letters, use those instead.) Input
casserole and click OK to send the letters to the
embroidery screen.
Select a hoop that
can accommodate
the width required,
such as the Large
Oval Hoop. (Smaller
hoops may be used
by breaking works
into two hoopings,
such as cass + erole). Rotate and resize the text as
needed (sample was rotated 270° and the height
adjusted to 25 mm). Note the location of the design
center.
Hoop two layers of stabilizers and embroider a test
swatch. Trim to make a 2” strip and hold it against
the base of the flap to check lettering height and
placement.
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Bond two layers of stabilizer together, then hoop them
as one unit. Spray with 505
adhesive and smooth the
end of one Flap piece into
place. Use the positioning
arrows to adjust hoop
placement as needed to
align the center of the
design with the marked
center on the fabric.
Embroider the lettering.
Repeat this process to
embroider hotdish at the
opposite end of the tote.
Construct the Casserole Tote as directed by the pattern
instructions, using the following presser feet to ensure
perfectly placed stitches:
• All seam allowances for this project at ¼”, so use
the edges of a quarter inch foot such as BERNINA
Patchwork Foot #37 as a guide for sewing all seams.

us
n
o
b

Cozy Wine Glass Coasters

• For stitching close to a folded edges, as when
attaching the pocket and making the casings for the
handles, use an edgestitch foot such as BERNINA
Edgestitch Foot #10 with the needle position adjusted
2-3 clicks to one side.

Project by
Elva Mungai
Download free instructions at:
www.berninausa.com
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Take a wardrobe staple from plain
vanilla to a full-flavored reflection
of your style. Snip and re-stitch
coordinating button-down sweaters
together for results that are far
from buttoned up!

Cardigan
Cut-Up
by JENNIFER GIGAS

Cardigan Cut-Up was featured in a recent episode of
“The Balancing Act” on Lifetime TV.

Select Your Sweater Palette
Sweaters for up-cycling projects may come from your
closet, resale shops, or the sale table of a favorite
department store.
From your closet, look for items that fit but may be past
their prime. Perhaps the color is over-powering, areas
are showing wear, or last year’s fashion trend is just a
little “too much” today.

Supplies
• 2-coordinating sweaters
• Construction-weight thread
• Ballpoint needle (size 80/12)
• Buttons
• Basic sewing machine
• ¼” foot (BERNINA Patchwork Foot #37 or
Patchwork Foot with Guide #57)
• Edgestitch foot (BERNINA Edgestitch
Foot #10)
• Button sew-on foot (BERNINA Button
Sew-on Foot #18)
When shopping resale stores, in addition to cardigans,
look for items with great buttons or trims that can be
salvaged for up-cycled project accents. Find a sweater
with great personality (color, neckline, ribbing, buttons,
etc.) but perhaps with a few stains or holes. Carefully
examine the piece to see if the there is enough material
for your project or an unblemished area that can be
rescued.
Department store sales are a good place to supplement
the items found in closets and resale shops. Be on
the lookout for appealing colors and textures that
coordinate with the materials you’ve gathered from
other sources.

Design Your Up-Cycled Garment
Look to catalogs, web shops, or high-end department
stores for inspiration. Don’t overlook home decor
magazines for trim applications or unique button
treatments.
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Before beginning your project, audition the sweaters,
buttons, and any other trims by laying them out
together on a flat surface. Any item “fighting for
attention” should be removed.

• Turn the “body” sweater piece so the buttons are at
the back. With right sides and raw edges together,
pin the ”yoke” sweater piece to the “body” piece
matching the side seams and centers.

Before cutting into your sweaters, put each one on in
front of a mirror and mark the planned cutting line with
painter’s tape. This will ensure that your seamlines will
not end up in unflattering locations.

• Attach a ¼” presser
foot to the machine
and stitch the two
sweater parts together.

Tip: The most flattering visual dividers split garments
into an odd number of segments (3/5/7) versus cutting
them in half.

Assemble Your Creation
Get started with the featured Quick Turn-Around
Sweater to get your creative cardigan-juices flowing.
Step 1
• Select two coordinating sweaters. Determine which
one will be the yoke.
• Try on the “yoke sweater” and mark a cutting line for
the lower edge of the yoke.
Tip: Avoid placing
your cutting line
directly across the
fullest part of the
bust.
• Align the two
sweaters on a flat
surface, right sides
up, and cut through
all layers using
your marked
cutting line as a
guide.
• Set aside the pieces
of each sweater
that will not be used
for this project.
Tip: Save unused
sweater parts for use
in future up-cycled
fashion projects.
Step 2
• Mark the front and back centers of each sweater.
Tip: Instead of measuring your sweaters, fold each
one in half sideways,” matching the side seams. The
front and back centers are at the fold lines.

Tip: Using a ¼” or
narrow straight stitch
foot makes it easier to
avoid buttons that may
be close to the seam
line.
• Press the seam
allowances toward the
yoke.
• Attach an edgestitch foot to the machine and move
the needle position toward the yoke. Topstitch close
to the seam line, securing the seam allowances to the
yoke.
Step 3 (optional)
• To stitch decorative buttons along the seam line,
attach a button sew-on foot to the machine and
select a button sew-on stitch. Hand-walk the machine
to verify that the stitch width is appropriate for the
selected buttons. Adjust if necessary to ensure that
the needle does not hit the button. Stitch the buttons
in place along the seam line as desired.
• For machines that do not have a button-sew on stitch:
Lower the feed dog and select a zigzag stitch. Adjust
the stitch width to match the distance between the
holes in the button.
Hand-walk the machine
to check the stitch
width and adjust as
needed. Stitch buttons
in place.
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Jerilynn's

Permission Purse

The Indygo Junction “Permission Purse” pattern
gives you “permission” to have fun with the
decorative stitches on your sewing machine,
using colorful threads and felted wool fabrics.
You can also use your BERNINA DesignerPlus
Embroidery Software 6 to design the squares,
giving you “permission” to play with endless
combinations of functions and stitches. After
sewing them on your embroidery machine, stitch
your embellished squares together following
the instructions included with the “Permission
Purse” pattern (available at your local quilt shop
or through IndygoJunction.com). Or use your
squares to make other projects such as coasters,
table runners, or pillows. Warning! Making these
little squares can be addictive!

by JERILYNN LIJEWSKI

Supplies
•
•
•
•
•
•
•

BERNINA DesignerPlus Embroidery Software 6
National Nonwoven WoolFelt®
Assorted threads in contrasting colors
Indygo Junction “Permission Purse” pattern
Medium Hoop
4½” square quilters’ ruler
Rotary cutting equipment

Note: The squares are cut to 4½” after the stitching is
done (a 4½” square rotary ruler makes this job easy), so
the final size of the digitized design should be no larger
than 110 mm (about 4.3”). This will give you a little
margin for your connecting stitches when you sew your
squares together.
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Let’s go step by
step through the
design process
for this wool felt
square:

Digitize the First Pattern Run
Open BERNINA Embroidery Software DesignerPlus 6
and select File > New.
Select View > Grid; the Options box will open. Place
check marks next to Show Grid and Snap to Grid. Set
Horizontal Grid Spacing to 10.00 mm (0.39”) and
Vertical Spacing to 10.00 mm (0.39”); click OK. Snap to
Grid allows you to line up your designs easily, and the
10.00 mm spacing is handy for measuring.

With the pattern selected,
select Arrange > Start and
End. Select First Stitch of
Design and Last Stitch of
Design; click OK. This will
reduce the number of jump
stitches.
Press Esc to deselect the
object.
"Permission Granted" to play with Pattern Stamp >
Other Pattern Sets when designing your own squares.

Digitize the Second Pattern Run
Open Object Properties. Under the Outline Stitch tab,
select Stitch Type > Pattern Run. Change Pattern Set to
Embellishment and select Pattern 618; click OK. Set Size
= 14 mm (0.55”) and Spacing = 14 mm (0.55”);
click OK.

Select Arrange > Pattern Stamp; the Select Pattern box
will open. Select Pattern Set 01 Monogram Ornaments
> pattern M098a; click OK.
The lower left corner of the screen contains prompts for
using the Pattern Stamp tool. Use the grid to keep the
pattern on a horizontal line. You are instructed to Enter
Anchor Point (left click) and then Enter Guide Point (left
click). Once the Guide Point is set, the software digitizes
the pattern instantly. To deselect the Pattern Stamp tool,
press Esc on your keyboard or select the Select Object
tool. Select the pattern you just made and change the
color to black to more easily see your work.
With the pattern selected, click on the Wreath tool
and select 4 wreath points from the drop down menu.
Three additional “ghost patterns” appear on the screen.
Move your mouse to maneuver the four patterns into
a pleasing square shape with sides touching. Press and
hold the Ctrl key on your keyboard to keep the patterns
on straight lines. Make sure the “bulls-eye” is in the
middle of the intersection to keep the resulting wreath
square. Left click to set the patterns. If you like the
result, press Ctrl + G on your keyboard to group the
wreathed patterns. If you do not like the results, click
the Undo icon and try again.
The default size of this square is about 83 mm (3.27”).
Make sure your object is selected, then select Object
Properties > General tab and change the Dimensions to
Width = 80 mm (3.15”) and Height = 80 mm (3.15”);
click OK.

Select the Open Object tool. Using the grid as a guide;
drag a straight line 100 mm (3.94”) long. (Remember
each box is 10mm (0.394”) square.) The instructions at
the lower left corner of the screen instruct you to enter
point 1 and then point 2; press Enter on the keyboard
to set the line. Press Escape on your keyboard to
deselect the Open Object tool.
Note: Because you selected Snap to Grid, the grid will
turn red when your line is straight. Also notice that that
as you drag your line, the length shows at the lower
right corner of the screen (L=100).
With the line selected, select the Wreath tool and
choose 4 wreath points from the drop down menu.
Maneuver the four lines into a square using the Ctrl key
to keep the lines straight. Keep the “bulls-eye” in the
center of the lines. Left click to set the design. Click Yes
if you get the message, “Do you want to merge the
overlapping objects?”
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Select Ctrl + G or click on the Group icon to combine
the four line objects. The size of the resulting square
will vary depending on how close you wreathed the
four lines. Select the new square and left click twice
to bring up the Object Properties box. Select General
> Dimensions and change Width to 108 mm (4.25”)
and Height to 108 mm (4.25”). Do not check the
Proportional Scaling box. Click OK.
Change the color of the
new square to black, the
same color as your first
Pattern Stamp square.
Select Ctrl + A to select
both squares, then click on
the Align Centers icon to
center them exactly. Press
Esc to deselect the objects.
"Permission Granted" to play with other Pattern Run
stitches and the Wreathing tool and create your own
designs. Try different sizes and spacing. You can always
size the resulting square by using Object Properties >
General tab. Remember that in this and most other
computer programs, there is more than one way to
accomplish a task. You may have your own favorite way
to resize. Experiment!

Digitize the Third Pattern Run
Open Object Properties; select the Outline Stitch tab
and change Stitch Type to Satin. Change Satin Spacing
to Manual, then change Stitch Spacing to 0.40 mm and
Stitch Width to 1.00 mm (0.04”). Click OK.
Select the Rectangle tool.
Starting in the upper left
corner of the design, drag a
square around the previously
digitized squares. Don’t
worry if it isn’t exactly square
or positioned where you
want it. Left click to set the
square. Press Esc to deselect
the Rectangle tool.
Select the new square and
double left click to open
Object Properties. Under the
General tab, change
the square measurements to
110 mm x 110 mm
(4.33” x 4.33”); click OK.
Press Ctrl + A to select all.
Click the Align Centers icon
to align the squares.

You can change the color of this outline to the same
color as the rest of the design at this point, but you
might, however, like to make each square a different
color for the stitch-out. "Permission Granted" to have
fun with threads!

Digitize the Fourth Pattern Run
Select the satin stitch square
you just designed; press
Crtl + D to duplicate it.
Double left click to open
Object Properties. Under the
General tab, change the size
of this new square to 20 mm
x 20 mm (0.79” x 0.79”).
Press Ctrl + A to select all,
then click on the Align
Centers icon. Press Esc to deselect the objects.
By now you are seeing repetition in how these final
squares are put together!

Digitize the Center Motif
For the center motif, open
Object Properties. Under the
Outline Stitch tab, change
Stitch Type to Pattern Run.
Select Pattern Set BerninaV5,
stitch NP005-11; click OK.
Change Size to 10 mm
(0.39”) and Spacing to 10
mm (0.39”); click OK.
Select the Open Object tool. Using the grid as a guide,
drag a straight line 10 mm long anywhere on the
screen. Enter point 1 (left click) and point 2 (left click),
then press Enter to set the line. Press Esc to deselect the
Open Object tool.
Select the new motif, then click on the Wreath tool and
select 4 wreath points. Press the Crtl key while dragging
to keep the lines straight; position them with sides
touching and the bulls-eye in the center. Left click to set
the design. Press Crtl + G to group the wreathed design
elements. Select the design;
left click on the Rotate 45°
CCW/CW icon to rotate the
motif 45° degrees. Change
the color of the motif as
desired. Press Crtl + A to
select all, then click on the
Align Centers icon to move
the new design to the
center of the square.
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Save your newly designed square as an ART file; you
can open and make changes to this file in the future if
desired. Select File > Card/Machine Write and send your
square design to a USB stick or to the My Designs folder
of your embroidery machine.

Embroider the Pattern Run Square
Hoop a single layer of WoolFelt® in the Medium Hoop
and stitch your design. Trim the square to 4½” x 4½”.
You’ve completed your first square!
You now have the basic skills to design your own
squares. Have fun with this! "Permission Granted"
to use the process described above to create a set of
pattern run squares that are uniquely your own.

For other projects featuring Jerilynn’s
embellished wool squares, see her
“Cleverly Stitched Cases” pattern
by Indygo Junction.

Jerilynn Lijewski
Jerilynn considers herself
foremost a teacher. She loves
to empower her students to
take basic ideas and make
them into their own unique
projects. To Jerilynn, BERNINA
DesignerPlus Software 6 is an
endless source of creativity and
play. Her patterns for Indygo Junction can be purchased
at local quilt shops or at Indygojunction.com. When
not teaching, Jerilynn lives with her husband, Carl, in
Northern Wisconsin, and spends most of her time in a
studio overlooking a scenic lake. You can see Jerilynn’s
almost daily projects at jerisew.blogspot.com.
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Allison’s
Needle-Punched Garden

by ALLISON STILWELL

Finished size: Approximately 12” x 14”
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This project is perfect for experimenting with
needle-punching, allowing you to try lots of
different fibers and textures and see what
happens to them as you create a garden of
colorful flowers. Allison Stilwell shares some
embellishment techniques, as well as tips for
making the “patchwork” border.
Supplies
• Assorted fibers and fabrics – silk dupioni, silk
hankies, silk velvet, cotton, wool felt, woven
wool, worsted wool, rug yarn, sock yarn, eyelash
trim, Angelina fibers, organza, gauze, felted wool
sweaters, etc. Experiment with fibers and fabric to
see what you like!
• Wool or wool blend felt (acrylic felt doesn’t hold
up as well as wool)
• 11” x 15” rectangle (any color) for base
• 6” x 18” teal rectangle for border/frame
• Assorted colors and sizes for flowers and birds
• Hand-dyed cotton gauze or similar loosely-woven
natural fabrics
• Rectangle of fabric large enough to cover the back
of the wall-hanging, plus 1” all around
• Light and dark green thread for leaves and stems;
white for clouds
• Embroidery floss and 5mm-wide silk ribbon
• Universal needles, size 80
• Hand-sewing needles
• Rotary cutting equipment

Background
Layer pieces of hand-dyed gauze (or similar looselywoven fabrics) over the wool felt base as desired: blue/
mauve sky, green/orange/yellow mountain, brown/
green/purple ground. Needle-punch the gauze into the
felt.
Add thin layers of roving over the gauze as desired for
clouds and shadows; needle punch into place.

Large Flowers
Cut curved shapes for stems from purple felt. Embellish
with yarn and Angelina fibers.
Cut leaf shapes from green felt. Embellish with olive
wool or other fiber/fabric.
Cut large (2” to 3” diameter) flower shapes from wool
felt or felted sweater knits. Embellish them using bits of
hand-dyed gauze, velvet, felt circles, swirls of yarn, and
other fibers/fabrics.
Position the flower pieces on the background, leaves
first, stems second, and flowers on top. Needle-punch
all pieces into the base/background.
• Flower #1: Orange felt, pink roving, purple velvet,
yellow yarn
• Flower #2: Lavender felt/gauze left over from sky,
orange felt, pink roving, blue felt, green French knots
• Flower #3: Purple felt, pink roving, swirls of multicolored yarn, Angelina fibers

Small Flowers
Create additional flowers as desired.

• Needle Punch Accessory Set

• Small blue flowers: Felt circles, yellow French knots

• Your favorite free-motion foot (Freehand
Embroidery Foot #24, Freehand Quilting Foot #29,
BERNINA Stitch Regulator)

• Medium purple/pink flowers: “Scrunched” layers of
purple organza, piles of multi-colored nubby yarn

• Edgestitch foot (Edgestitch Foot #10/10C)

• Tall yellow flowers: Penny-sized discs of yellow roving,
hand-stitched orange stamens

• Open-toe foot (Open Embroidery Foot #20/20C

Miscellaneous
Add details to your garden as desired.

Border
Cut strips of assorted fabrics and lay them in
overlapping rows on a piece of felt. Needle punch in
place.
Tip: Mix in some prints and stripes for more visual
interest, such as the black-and-white stripe used here.
Use a rotary cutter to cut 1”-wide strips of striped
“frame” fabric. Set aside.

• Purple Geometric Forms: Two rectangles and one
circle of purple velvet, with pieces of purple lamé on
top, hand-stitched green X’s
• Birds and Caterpillar: Teal felt and assorted fabric
scraps left over from the strips around the edge
• Clouds: Loosely woven light lavender wool, roving,
Angelina fibers; free-motion outline and swirls
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BERNINA Needle Punch Accessory Sets

rota ry h o o k
We all love our Needle Punch Tools, but until recently
this attachment wasn’t available for rotary hook
machines such as the artistas and 8 Series machines.
Now everyone can play with this fun accessory!

Final Touches
Trim the rectangle to 10” x 12” using a rotary cutter,
mat, and ruler.
Attach the edgestitch foot to the machine. Place one
long edge of the flower-scape under the left side of the
foot and the border under the right side of the foot;
bring the edges together to meet at the center guide of
the foot. Stitch the two pieces together using a 5 mmto 9 mm-wide decorative stitch. Piece as needed. Trim
ends even with the edges of the flower-scape.
Repeat for the remaining long edge.
Using the same stitching technique, frame the upper
and lower edges of the flower-scape. If desired, use
strips cut from the outer edges of the striped border
piece; this creates loose ragged edges that contrast with
the straight lines at the edge of the piece.
Turn under the edges of the woven cotton backing
fabric to create a rectangle slightly smaller than the
completed flower-scape. Pin it to the back of the
finished piece.
Attach the open-toe embroidery foot to the machine.
Select a decorative stitch (such as a satin-stitch arrow)
and thread the machine with decorative thread. Stitch
around the outer edges, ¼” to ½” from the raw edges.
Allison Stilwell is a quilter
and mixed media artist from
sunny Florida. She and her
sister Tracy were the creative
collaborators behind Artgirlz,
Inc. These days Allison gets
to spend more time in her
studio attempting to be
open, silly, and free having
fun making art.

The BERNINA Needle Punch Tool does the same job
a hand-felting tool does, but is so much quicker
and easier. Simply place the embellishments (roving,
yarn, fabric, etc.) on the base fabric, place it under
the Needle Punch Tool, and go. Don’t worry about
going outside the lines – it doesn’t matter! There’s
no thread, so all you need to do is move the fabric
around until all of the fibers have been punched into
the base.

n ew!

Rotary Needle Punch #45 for Rotary Hook Models
• aurora 435/450
• BERNINA 580
• artista 180/185/640/200/730
• BERNINA 820/830
Original Needle Punch Tool for CB Hook Models
• activa (all)
• virtuosa (all)
• BERNINA 330/350/380
• BERNINA 530/550
• aurora 430/440QE
• artista 630/635

cb hook
Note: Whether you’re
using the Original or Rotary
Needle Punch Accessory, be
sure to use the corresponding Needle
Punch Stitch Plate when using your Needle
Punch Tool – otherwise your needles will hit the
stitch plate and break! Needle Punch Stitch Plates
have a large opening in front of the needle hole
to accommodate the multiple felting needles that
penetrate the fabric.
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The Last Word
A sneak peek at what’s coming in
Through the Needle ONLINE, Issue #11:
BERNINA 830 Quilt
Love the embroidery designs included with
the BERNINA 830, but don’t know what to
do with them? Mary Ann Kotowski (Sew
Right, Bayside, NY) used them to create a
striking black, white, and red wall-hanging.
See how she did it in TTNO Issue 11.

Cardigan Cut-ups 2
More up-cycled sweater fashions from
Jennifer Gigas. Collect a few cardigans
and pullovers to dissect for parts, then
re-assemble the pieces into simple-tosew, up-to-date garments.

February 2012 Special

25% OFF

Apply single or double
cording in a snap
Two deep grooves beneath these
presser feet allow you to apply
one or two thick cords quickly and
easily to your home dec projects!
For February 2012 only, get 25%
OFF BERNINA Double Cord Feet
#59 and #60

Double Cord Feet
#59 and #60

Offer good February 2012 at
participating BERNINA dealers in the
United States. Coupon may not be
combined with any other offer.

March 2012 Special

25% OFF

Gathering is easy with the
right presser foot
Use Gathering Foot #16 to gather
a single layer of fabric or apply a
gathered layer to an ungathered
layer in one simple operation!
For March 2012 only, get 25%
OFF BERNINA Gathering Foot #16

Gathering Foot #16

Offer good March 2012 at participating
BERNINA Dealers in the United States.
Coupon may not be combined with any
other offer.

Quick Links
These are the main links featured in this issue;
see the articles for links to specific products,
projects, and technique information. Please visit
our sponsors and contributors for more inspiration,
information, and stitching fun!

•
•
•
•
•
•
•
•
•
•
•
•

www.throughtheneedle.com
www.berninaUSA.com
www.WeAllSew.com
www.benartex.com
www.embroideryonline.com
www.bernina8series.com/EN/
www.berninamylabel.com
www.facebook.com/berninausa
www.rickytims.com/seminars
www.allisonstilwell.blogspot.com
www.jerisew.blogspot.com
www.blowssewandvac.com

Until April ...
As always, we hope this issue of Through the Needle
ONLINE has inspired you to learn something new and
make your own adaptations of our projects. We love
seeing your creations; send e-mail and photos to
jo@berninausa.com.

